
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Version 10 Addendum Manual 
 
 
 
 
 

 
Suite 314, 602 – 11th Avenue S.W. 

Calgary, Alberta T2R-1J8 
Phone: (403) 777-9454  Fax: (403) 777-9455 

Website: www.powerlogger.com  Email: info@powerlogger.com 
 



                             Addendum User Manual Version 10 
 

Overview 
 
We have added the ability for the user to Export and Import their INI settings. This would include their 
favorite’s lists, window placements, printer settings, printed settings, toolbar positions, % lithology sort 
order, backup folders, last opened wells, most of their System Options settings etc. This utility will help on 
the initial setup of our application on a new computer with a new install or upgrade. 

We have added another Printing Method that will print the Well End and Morning reports to a Word 
for Windows TM format. These reports can be easily edited and formatted to the report formats that the 
user desired so now you can distinguish your reports from others that use our system. Also gave the AM 
reporting reports printing tool a little more functionality where the user can easily add Casing, Bit Record 
and Survey data to make the AM reports a lot more complete by simply clicking a check box. 

We have completely revamped the Curve Editor window so the user can now utilize the windows 
functionalities to select all the data between two points (ie SHIFT Key) or indicate individual values (CTRL 
Key) or even select all the values in a curve and deleting them easily. 

We have added the ability to turn off the line separating the track borders in the header to go along 
with the main log portion that had been implemented in previous versions. 

We have added some Generic Symbol layers (both Non bed and bed restricted) to Power*Core where 
the users can add and build symbols for any Data type that is not included with the software. It has all the 
functionalities of the Sedimentary structures layer as to give you an example. The user can build as many 
data groups as they wish to show their data on a Core log. 

With this new layer we have also added the ability to populate a favorites list for any User defined 
Generic Symbol category. This can be found with the other favorites list that has been accommodated in 
the System Options Favorites Tab. 

We have revised the Metafile Options window to be able to rename both Long and Short names for any 
user defined symbols. We also retain any of the user defined custom colors that were used to draw with 
during the symbol creation process. 

We have added another Curve fill layer which will utilize the interpretive lithology and wrap that lithology 
around the Well path curve. The revolutionary part of this is that we are now able to define the bedding 
angle contacts and the extents of the beds over any depth. This will greatly enhance any horizontal log 
presentation and will do so with minimal 
effort.
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We have added a generic Change layer. This can be used for Energy Sea level or any other data type 
that can be represented with a curved arrow. 

 
We have added another Alternate Core Header that will give the user more information in the header as 
well as a way to print the header in the Print Log window 

We have added an additional functionality so that the user to drag and drop Casing display data 
anywhere on the layer. 

We have added an additional functionality so that the user to drag and drop Bit Record display data 
anywhere on the layer. 

We have added an additional functionality so that the user to drag and drop Formation Top display 
data anywhere on the layer. 

We have added an additional functionality so that the user to drag and drop Directional Survey display 
data anywhere on the layer. 

We have added an additional functionality so that the user to drag and drop Graphics anywhere on the 
layer. 

We have added some more functionality to our Curve displays. If you have utilized Point Indicators on 
you curve layer (with or with the curve line style) we have added those Indicator Points to the Track 
header. If you have a curve scale change we will now draw the curve from and to the scale change 
depth and indicate the scale change depth with a solid line that can be turned on and off by the user. 
This can be done in the layer configuration window. We have also given the user the control to change 
the line color and thickness of the Scale Change Curve Indicator through the right click curve pop out 
menu. Also if a linear curve wraps off scale for a second time and pegs to the track border we can now 
indicate the off scale curve values on the layer. As always the user will have control of this functionality 
and also the control of the font that is used to display the data. 

We have also given the user full control on the display for all of the fonts that are used on the log. 
With this version we have added the Core box data display, Core Sample Code, off scale curve values, 
Generic Category verbiage, Sidewall Core layer font, MDT layer font, Casing String and Date layer fonts. 

We have added the ability to delete a line in the Annotation right click menu options. 

We have added some more functionality to the Accessory portion of the Detailed Rock type builder. 
We have given the user the ability to move accessories as well as delete multiple accessories at one 
as well as define an are to delete accessories within an area for those that are hard to find on a right 
click delete option. 

We have added some revisions to the drop lists in the Rock Type Builder. In the Sample Quality List 
we have added Rubble to help out our core loggers. We have also added Preserved and Missing to the 
No Data list and last but not least we have added Questionable and Not visible to our Contacts list. 

We have added a TVD Thickness field to the Formation Report. This can be calculated automatically 
for you if you have a formation top that is deeper than the top you would be calculating for. We have 
revamped all the reports to also include this field. 

We have added the ability to export everything at once and includes all the well data, the user defined 
symbols, the generic categories, the geological expansion dictionary and all the favorites lists, the window 
and toolbar placements and all the things determined in the system options window. This will make 
upgrading and migrating from one computer to another very simple. 
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Revised Data Transfer Export Utility 

New - Exporting everything at one time… 
This would include all the Well data, Generic Categories, Well Symbols, Geological Expansion Dictionary, 
Favorites and all the Power*Suite initialization files . 

1. Select Import/Export, under the File menu selection, and then select Export Log/Well from the sub-menu.  

Or, you can click on the  Export Log / Well button on the Toolbar. 

 

2. Click on the  button. This will activate a system message. 

 

3. Click on the  button. This will activate a Choose Directory window. You may wish to create a 
new folder for these well. This cannot be done from this window and must be done through Windows 
Explorer or My Computer. In the example an old wells folder is selected. 
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4. Click on the drive and directory where you wish the well data to be exported to. Then, click on the 

 button. This will activate the Exporting window. 

 
5. When the export all well data is finished a System Message will be activated as shown below. Click on the 

 button. Below you will view the folder created in the PowerSuite V10 \ Backup \ Todays 
backup with files and their names. 

 

    
 
You will notice that the well export will have the log names, and the other exports associated with this backup all 
feature will have a time stamp after the file type. 
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New - Export INI Settings 
This will allow the user to export all the user’s favorites’ lists, the placement of the toolbars, window placements and 
default settings for another user to import to have all the settings the original user has set up. 

How to Export INI Settings 
 
1. To access the INI Export window, click on Import / Export under File to activate the pop-out menu and then 

select Export INI Settings. This will activate the Export INI Settings file window as shown below and tells you 
the folder it has been saved into as IBF file extension. 

    

New - Import INI Settings 
This will allow the user to import all the user’s favorites’ lists, the placement of the toolbars, window placements and 
default settings from another user who has exported this file and to have all the settings the original user has set up. 

How to Import INI Settings 
 
1. To access the INI Import window, click on Import / Export under File to activate the pop-out menu and then 

select Import INI Settings. This will 
activate the Open INI Backup file Settings 
file window as shown below. 

    

Addendum Manual Version 10, page 8 



 Addendum User Manual Version 10 
 

2. Select the file that has been exported and click on the  button. This will result in a system message 
that the file has been imported successfully as shown below. 

 
 

New - Print “Well End and AM” Reports to Word Format 
This printing method has been implemented to facilitate the printing of the Geological reports to a different 
format other than the Crystal Reports generated to this point in time. Most of the reports are very similar but 
are not just text fields that our users have had some problems with when they are printed to word format. 
This new geration of reports should be easily formatted to their particular reporting format. 

 
1. Click on Print Reports to Word, under the File menu selection, to activate the Print Reports to Word window 

shown below. The user can also click on the Shortcut button  located on the toolbar. 
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Overview of Well End Reports Tab Window 
Prepared for Fields are to be filled in for the Title page report. Type in the Company Name
you are working for in the company field and the Person’s name you are working for or is
receiving the reports in the Name field

 
 

 
 

Prepared by Fields are to be filled in for the Title page report as well. Type in your 
Company Name in the company field and your name in the Name field 
 

 This field defaults to the well that is 
open when you enter into this application. The user can utilize the drop arrow to pick any well they have in their 
database. 

The Depth Range fields are available to print a portion or depth interval of the 
Sample or Core descriptions as well as Devon Malibu Format Moring Reports. Lea
these fields blank to print the

ve 
m all. 

re Activate this check box if you want to include the Formation tops in the Sample or Co
Descriptions report. 

 
 
 
 
 
This field gives the user to identify which well end reports they would like to print  and 
they can also identify multiple reports to print at once. Click on the report name to 
activate or highlight the report to be printed and Click again to deactivate the report. 
Scroll through the list to identify which reports you wish to print. 
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Activate this check box if you wish to print multiple reports to a single file. Or conversely deactivate 
this check box if you want multiple files created. 
 

 
. 

 

 
 

This button will highlight / select all the reports and you can activate the reports you do not wish to
print

This button will dehighlight / deselect all the reports and you can activate the reports you wish to print. 
 

This button will activate the printing process and create either single or multiple files. The documents
created will be Document 1 Document 2 etc.

 

How to Print Well End Reports to Word Format. 
1. Click on Print Report to Word, under the File menu selection, to activate the Print Reports to Word window. 

The user can also click on the shortcut  button located on the toolbar. 
2. Choose the well you wish to create a report for from the selection box if the default well is not the one you want 

to print. 
3. Highlight the reports you wish to print in the Reports field by clicking on them once. To select/highlight all of 

the reports, click on the  button. To deactivate all of the reports, click on the  
button. . If you are printing sample or core Descriptions select if you wish to print tops or all the 
descriptions. 

4. Click on the  button to create the reports. This will activate your copy of MS Word application and 
you can view, customize and save these reports. 
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Overview of Morning Reports Tab Window 

 
 

This field defaults to the well that is open when you enter into this application. The user
can utilize the drop arrow to pick any well they have in their database.

 
 

 

 

 
This field gives the user the ability to identify which Morning reports date they would 
like to print. The user has the ability to print one or more report dates. Select or 
deselect them by clicking on them once. 
 
 
This identifies which portion of the report they would 
like to print. The choices will be activated with a 
check box. This information is entered into the 
Morning reports located under the Reports pull 
down menu in Power*Log / Core or Curve. 
 

 
 
 
This portion of the window allows the user the ability to pick and choose which of 
the Well End reports they would like to include with the printed am report. They 
include Bit records Casing Formations and Surveys. All these records default to 
the depth interval from the previous morning report but can be modified by the 
user. 
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This   button activates the Set depth range window so the user can 
decide what ranges of well end report data to include with the AM report printing. 
The default is the depth from the previous Am report and the one you have selected 
to print. 
 
 
 

Activate this check box if you wish to print multiple report dates to a single file. Or conversely 
deactivate this check box if you want multiple files created. 

 

The  button will highlight all the am report dates. 

The  button will deselect all the am report dates. 

The  button will activate the printing process and create either single or multiple files. The documents 
created will be Document 1 Document 2 etc. 
 

How to Print Morning Reports to Word Format. 
 
1. Click on Print Report to Word, under the File menu selection, to activate the Print Reports to Word window. 

The user can also click on the shortcut  button located on the toolbar. 
2. Click on the Morning Reports tab to activate that portion of the window. 
3. Choose the well you wish to create a report for from the selection box if the default well is not the one you want 

to print. 
4. Highlight the report dates you wish to print in the Dates field by clicking on them once. To select/highlight 

all of the reports, click on the  button. To deactivate all of the reports, click on the 

 button. 
5. Select the report options from the appropriate check boxes. 
6. Select from the Single Report Options which data from the well end reports you would like to include in this 

printed AM report. 
7. If you have selected some Well End report data to be included with the AM report printing and you would like to 

change the default depths to search for a different interval of data then you would Click on the  
button to activate the window and change the depths accordingly. 

 

8. Click on the  button to return to the main window. 

9. Click on the  button to print the AM report to word format. This will activate your copy of MS Word 
application and you can view, customize and save these reports. 
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Revised - Track Configuration 
This is the only window that allows you to offset tracks* and add information to individual track headers. This window 
will also allow the user to turn off the outside border of any Track. 
A track is a portion of the log that contains one or more layers of information. The track configuration window can be 
used to edit the name of the track, the track header, and the track's depth offset in relation to the rest of the tracks 
within the log. The user must keep in mind that any track can be offset with respect to its actual depth. A positive 
integer will increase the depth of the track, while a negative integer will decrease the depth of the track. To be able to 
work within or on a track, the track must be ACTIVE: highlighted with a green border. The Track configuration will 
also allow the user to turn off or on the track borders between tracks. 
*Track Offsetting is only available to those users possessing the Correlational Module. 

Shortcut:   
This is the Track Configuration window: 
 

        
 
Editing the Active Track Configuration… 
 
1. Click on the desired track to make it active: highlighted with a green border. 

2. Click on Track Configuration, under the Edit menu selection, or click on the  Track Configuration 
button on the Toolbar to activate the Track Configuration window shown above. 
 

Note: You may also access the Track Configuration window by clicking on the  button within 
the Log Configuration Builder window, once you have highlighted the track you wish to edit. 

Adding a Track Header 
3. Type the desired Header information into the Heading fields within the window. 

Offsetting or Depth Shifting a Track: (Correlation Module only) 
4. Type the offset figure into the Depth Offset field within the window. 

Note that a positive integer will increase the depth of the track (move it down), while a negative integer will 
decrease the depth of the track (move it up). 

Changing Track Borders for the main log 
5. The user can turn off and on the borders between tracks on any log. The Track border is turned on when the 

check box  is activated or selected and is turned off when the check box is deactivated or unselected . 

Changing Track Borders for the track header 
6. The user can turn off and on the borders between tracks on any log. The Header border is turned on when the 

check box  is activated or selected and is turned off when the check box is deactivated or unselected . 
 
Note: To turn off the border between two tracks the left or bottom selection of one track and the right or top 
selection from the adjacent track must be deactivated or unchecked. 
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7. Click on the  button or press ALT-S. 
8. A system message will appear telling the user “Record saved successfully. Do you wish to Exit?” Click on the 

 button to exit the window and view your changes. 
 
Field Restriction Table: 
 

Name 30 Character Mandatory 
Sequence 5.0 Numeric Optional 
Width 3.2 Numeric Optional 
Depth Offset 5.2 Numeric Optional 
Current Layer 30 Character Optional 
Remarks 100 Character Optional 
Heading (1, 2, & 3) 30 Character Optional 

Revised Layer Configuration 
The Layer is the lowest level of a log. A layer is part of a track, which in turn is part of a log. The Layer 
Configuration window allows you to edit all aspects of any given layer. You have access to all layer 
attributes, including curve attributes, layer grid styles and patterns and layer display controls. You may also 
control the display format and depth offset of layers in this particular window. None of the layer data types 
use all the layer controls. 
 
A layer is a set of information that is displayed on a track. A track can consist of one or more layers. The layers are 
positioned within a track and are superimposed or stacked on top of one another, if there are multiple layers in a 
track. You are able to show/hide the layers and adjust the layering order. This can be done in the Layers Organizer 
window located under the view pull down menu. 
You can only work with one layer at a time and we call this the active layer on an active track. Layer information is 
restricted to the Primary Well of your log, unless you have the Correlational Module, which allows a layer to be 
pointed at any well in the database. A layer can access any type of information in the Primary Well or any other well 
in the database and display it within the log.  A layer can be offset on its depth axis to make correlations between 
wells relatively simple. 
In the Layer Configuration window, you are able to associate specific Annotation Groups with Annotation layers 
via their Annotation Group ID. The user can also associate specific Data Groups with a specified layer. 
 
Note: The Correlational Module allows you to access all of the UWI's or wells in the database in order to display 
their information in comparison with the current Primary Well on the same log. 
 
There are numerous Data Types for Layer Configurations. Each data type viewed below are shown in the 
data type field of each layer and it represents what type of data each layer can show. For instance a Curve 
layer can only show curves. The directional survey layer can only show survey data. These data types are 
listed below. 
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Accessories 
Age (Era/Series/Stage) 
Annotation (Track) 
Annotation (Log) 
Bedding Contacts 
Bioturbation 
Bit Record 
Carbonate Texture 
Carbonate Texture Matrix 
Casing Data 
Change Energy / Sea Level 
Core 
Core Box Data 
Core Bulk Density 
Core Grain Density 
Core Permeability Kmax 
Core Permeability K90 
Core Permeability KV 
Core Permeability K Air 
Core Porosity Calculated 
Core Porosity Helium 
Core Porosity Measured 
Core Sample Code 
Curves 
Curve Fills 

Date / Drilling Schedule 
Depth 
Detailed Lithology 
Diagenesis 
Dip Meter Data 
Directional Survey 
Formation (Group / 
Formation / Member) 
Formation (Short Name) 
Formation (Long Name) 
Fractures 
Framework 
Generic Category 
Generic Symbol 
Grain Size 
Grain Size Matrix 
Graphics 
Hole Dip Meter Data 
Interpretive Lithology 
% Lithology 
Lithology Descriptions 
MDT Data 
Multi Array Curve layer 
Oil Show 
Oil Staining 

Percent 
Porosity Grade 
Porosity Type 
Rounding 
Core Saturated Bulk Mass – Fluids 
Core Saturated Bulk Mass – Oil 
Core Saturated Bulk Mass – Water 
Core Saturated Bulk Mass – Solids 
Core Saturated Bulk Mass – Totals 
Core Saturated Grain Mass – Oil 
Core Saturated Grain Mass – Water 
Core Saturated Pore Volume – Oil 
Core Saturated Pore Volume – Water 
Core Saturated Pore Volume (Frc)- Oil 
Core Saturated Pore Volume (Frc)- Water 
Sedimentary Structures 
Sidewall Cores 
Slide / Rotate 
Snieder’s Rock Type Geology 
Snieder’s Rock Type Core 
Sorting 
Surveys 
Tests 
Trace Fossils 

Shortcut:   
 
This is an example of our Tab Dialogue Configuration window for a Curve Data Type Layer: 
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Revised General Display Tab 

 
 
We have added an additional  check box to handle Curve Scale changes. 
This display check box along with the right click pop out menu additions to handle the scale change line 
indicator color and thickness will give the user some additional controls. We will also draw the curve to and 
from the line indicator. 

The  field in yellow is a mandatory field. This is the name that is displayed for a 
layer or a curve irregardless of the Curve you have identified to show on this layer within the Curve Definition Tab of 
this dialogue window. 

  If this box is checked (default), indicates that the Curve Scale or Layer 
heading will be displayed in the track header. 

- If this box is checked (default), indicates that the layer is being displayed. 

 If this box is checked indicates that the Layer heading will be displayed 
vertically in the track header. If unchecked it will be displayed horizontally. 

 If this box is checked (default), any time a curve goes off scale or wraps the curve is 
hatched and the backup scale is viewed on the Layer. 

 If this box is checked (default), any time the user changes scale a line will run 
across the layer (color and size to be found in the right click curve menu only) indicating a scale change. 

 If this box is checked (default), it will display the scales (including scale changes) 
for a curve on the log will be shown regardless of which layer is active at the time. 
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 If this check box is activated it will display all the major cycles will be labeled. If this is 
unchecked or deactivated only the two end borders of the scale will be activated. 

 If this box is checked (default), it will display the Depth Axis Grid (X-axis), Horizontal grid 
lines in Power*Log and Vertical grid lines in Power*Curve as defined in the Log Configuration Layer Scale Tab 
Dialogue window. 

 If this box is checked (default) it will display the Data Axis Grid (Y-axis) Vertical grid lines in 
Power*Log and Horizontal grid lines in Power*Curve, as defined in the Log Configuration Layer Scale Tab 
Dialogue window Data Axis Grid Style. 

 UWI Button 
Normally, the UWI field within the Layer Configuration window should be blank, because the layer normally exhibits 
data from the Active or Primary Well on the current log. This Button or field (if you have the Correlational Module) 
will allow you to exhibit another wells data. 
 
Note: If you decide to use this log as a template for creating future logs and refrain from clearing the UWI field(s) in 
the Layer Configuration window(s), then all future logs created from this template will contain layers pointing to 
another UWI. 

If you possess the Correlational Module, you can use the  button to access data from other UWIs or wells 
within the database. 

 

Revised Data Group ID’s Tab 
This tab in the layer configuration window allows the user to change the specific data groups available for each Layer 
type. An example is shown below: 

 
We have added the Ability to Display Multiple Visual Range and Generic Symbol groups on a log. 
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Once a field in this Layer Configuration Tab dialogue window has been changed the user must then click on the 

 button or press ALT-S. 

Annotation Group Button 
The  button allows you to associate an existing Annotation Group with the Annotation layer 
active within the Layer Configuration window at the time. Each Annotation Group has a unique Group ID as they 
are assigned when a new log is created for a well. So for every annotation layer that is associated with a well there is 
a new Annotation group created. Accordingly, if you have multiple Annotation layers associated with a single well, 
then you will have to assign a unique Group ID number to each of the Annotation layers within each of their 
respective Layer Configuration windows. 
For example: "Comments" is an Annotation layer, that when a well/log was first created was assigned an Annotation 
Group ID of Comments1 with its own Layer Configuration window. Meanwhile, "Remarks" is another Annotation 
layer in that same well/log creation, that has been assigned Annotation Group ID Remarks1 within its own Layer 
Configuration window. If another log is created for the same well that has both a Remarks and Comments Layers 
they each will be assigned Group ID’s of Remarks2 and Comments2. The new log will not show the same 
comments as the original log. You can show any group of annotations on any annotation layer and this is shown 
below. 

Generic Category Button 
You can use the  Generic Category button only when the Data Type field 
displays, "Generic Category.". The user can use this button to associate a Generic Category Group and its 
associated data with a layer. Generic Category Groups are listed by their Name. 

MDT Run Number Button 
You can use the  MDT Run Number button only when the Data Type field 
displays, "MDT." 
The user can use this button to associate a MDT Run Group Numbers and its associated data with a layer. A layer 
can be associated with only one MDT Run Number Group and its associated data. MDT’s are listed by their Run 
Number and can be selected by utilizing the drop box and selecting the according number from the List. Then click 

on the  button. 

Directional Survey Button 
You can use the  Directional Survey button only when the Data Type field 
displays, "Directional Survey." The user can use this button to associate a Directional Survey Group and its 
associated points with a layer Directional Survey Groups are listed by their Start Date and their Survey Group ID. The 
default for any Directional Survey Layer is for it to display the Survey Group ID 1and its associated points. 

Graphics Button 
The  Graphics Groups button is used, when a Graphics layer is the currently 
active layer within the Layer Configuration window. The Graphics Group button allows you to associate an existing 
Graphics Group to the currently active layer. Graphic Groups are listed by their Group Number / Name and can be 

selected by utilizing the drop box and selecting the according number from the List. Then click on the  
button. 

Detailed Lithology Group Button 
The  Detailed Lithology Group button is used, when a Detailed Lithology layer 
is the currently active layer within the Layer Configuration window. The Detailed Lithology Group button allows 
you to associate an existing Detailed Lithology Group to the currently active layer. 
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Each Detailed Lithology Layer added when creating new logs for a well or adding a Detailed Lithology layer/track to 
a log is assigned a unique Detailed Lithology Group ID. So for every Detailed Lithology layer that is associated with 
a well there is a new Detailed Lithology group created. Accordingly, if you have multiple Detailed Lithology layers 
associated with a single well, then the system will have to assign a unique Group ID number to each of the Detailed 
Lithology layers within each of their respective Layer Configuration windows. 
For example: The First Detailed Lithology layer added to a well/log is assigned a Detailed Lithology Group ID of 
Detlith1 with its own Layer Configuration window. Meanwhile, if another Detailed Lithology layer is added in a new 
log creation that will be assigned another Detailed Lithology Group ID Detlith2. Etc. Etc. Etc. 

Dip Meter Group Button 
The  Dip Meter Group button is used, when a Dip Meter layer is the currently 
active layer within the Layer Configuration window. The Dip Meter Group button allows you to associate an 
existing Dip Meter Group to the currently active layer. Dip Meter Groups are listed by their Group Name and can be 

selected by utilizing the drop box and selecting the according name from the List. Then click on the  
button. 

New Visual Range Button 
The  Visual Range Group button is used, when a Visual Range layer is the 
currently active layer within the Layer Configuration window. The Visual range Group button allows you to 
associate an existing Visual range Group to the currently active layer. Dip Visual range are listed by their Group 
Name and can be selected by utilizing the drop box and selecting the according name from the List. Then click on 

the  button. 

New Generic Symbols Button 
The  Generic Symbols Group button is used, when a Generic Symbol layer is 
the currently active layer within the Layer Configuration window. The Generic Symbols Group button allows you to 
associate an existing Generic Symbols Group to the currently active layer. The Generic Symbols Group are listed 
by their Group Name and can be selected by utilizing the drop box and selecting the according name from the List. 

Then click on the  button. 

Revised - Metafile Options 
This option allows the users to edit any existing metafiles or symbols within the PowerSuite applications (i.e. 
rock types, accessories, structures etc.) or add new Metafiles or symbols to our lists for the more 
sophisticated users. 
We have given the user the ability to rename either the short or long names for the User Defined symbols 
they have created. 

How to Edit an Existing Metafile 
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1. Click on the Metafile Options selection located under the Edit pull down menu. This will activate the Metafile 
Options window. 

 
2. Click on the category of the symbol you wish to modify or edit. This will activate a list of existing symbols shown 

on the right hand side of the window. 
3. Click on the Symbol you wish to edit. It will become highlighted and fill in the edit field. 

4. Click on the  button. This will activate a System Message window shown below. 

 
Note: A (two) 2- pane window shows the metafile in regular and expanded views. A single pane window shows 
the metafile in an expanded view only. 

5. Click on either the  or  button and the Power Metafile Editor will open with the 
selected symbol in the window that you had selected. 

Note: The Rock Type window shown below is a two pane window and is different from any other Metafile 
window. The upper pane shows the actual screen or print size. The difference with the rock type window is that 
the upper pane shows the metafiles repeatability. The upper pane is placing the same metafile staked on top of 
each other and left to right attempting to show the user the metafiles repeatability. This is essential when creating 
or editing rock types because they should be repeatable so when printed they will appear seamless when drawn 
on the screen or printouts when the region is larger than the metafile. 
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The toolbar functionality’s are defined in the illustration shown below. 

 
Note: Lines on sedimentary structures / trace fossils will change color if line width is 1. 

6. The lower or expanded portion of the window is the editable portion. With the mouse you can select a line, 
rectangle, polyline or other shape tool and draw in this window. You can move the lines or shapes by dragging 
the shapes, copy or delete by using the toolbar or keyboard keys or buttons. Use the drop down menus or the 
toolbars to select the different options the user can utilize. 

7. Once the metafile has been modified to your specifications the user must click on the  Save button on the 
toolbar or click on the File pull down menu and select Save. 

Note: There are two save choices. The Save Mono is done automatically for you when you save the metafile. In 
other words the color metafiles are converted to black and white metafiles and saved to the Powersuite/symbolm 
folder. These mono metafiles come in useful when printing to a black and white printer. The color symbols are 
saved to Powersuite/symbol folder. 

8. Exit the Power Metafile Editor by clicking on the X in the upper right hand corner of the window or click on the 
Exit selection located under the File pull down menu. This will put the user back into the PowerSuite 
Application Metafile options window. 

9. Repeat steps 2-8 to edit more existing metafiles. 

10. Click on the  button in the Metafile Options window to exit this window. All the changes will be 
reflected in the Choice lists, printed legends and on the screen and printed metafiles. 

How to Add a New Metafile 

     
1. Click on the Metafile Options selection located under the Edit pull down menu. This will activate the Metafile 

Options window shown below. 
2. Click on the category of the symbol you wish to add a new symbol to. This will activate a list of existing symbols 

shown on the right hand side of the window. 
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3. Click on the  button. This will activate the Metafile Options (Add Metafile) window. 

 
4. If you have selected the components category the user must select the appropriate accessory, fossil, grain or 

texture Sub Category drop box. 
5. Type in a short name and a long name into their respective fields for your new metafile. These will appear in 

the choice lists and will be exported in the ASCII Lithology export file. 

6. Click on the  button. This will activate a System Message window if you have selected any other 
category other than rock. 

Note: A (two) 2-pane window shows the metafile in regular and expanded views. A single pane window shows the 
metafile in an expanded view only. 

 

7. Click on either the  or  button and the Metafile editor will open a blank Power 
Metafile Editor window with a file name that is a combined short name and category name. 

Note: The Rock Type window shown below is different to any other Metafile window. The upper pane shows the 
actual screen or print size The difference with the rock type window is that the upper pane shows the metafiles 
repeatability. The upper pane is placing the same metafile staked on top of each other and left to right attempting 
to show the user the metafiles repeatability. This is essential when creating or editing rock types because they 
should be repeatable so when printed they will appear seamless when drawn on the screen or printouts when 
the region is larger than the metafile. 
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The toolbar functionality’s are defined in the illustration shown below. 

 
8. The lower or expanded portion of the window is the editable portion. With the mouse you can select a line, 

rectangle, polyline or other shape tool and draw in this window. You can move the lines or shapes by dragging 
the shapes, copy or delete by using the toolbar or keyboard keys or buttons. Use the drop down menus or the 
toolbars to select the different options the user can utilize. 

 
Note: The Polyline and Polygon drawing tools require a double click to finish the action. The text tool font size is 

determined by the height of the field. Once an action is performed the default reaction is to place the emphasis 
back on the select tool. 

 

 

9. Once the metafile has been designed to your specifications the user must click on the button on the 
toolbar or click on the file pull down menu and select Save. 

Note: There are two save choices. The Save Mono is done automatically for you when you save the metafile. In other 
words the color metafiles are converted to black and white metafiles and saved to the Powersuite/symbolm 
folder. These mono metafiles come in useful when printing to a black and white printer. The color symbols are 
saved to Powersuite/symbol folder. 

10. Exit the Power Metafile Editor by clicking on the X in the upper right hand corner of the window or click on the 
Exit selection located under the File pull down menu. This will put the user back into the PowerSuite 
Application Metafile options window. You will now view you new creation in the appropriate list.  
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11. Repeat steps 2-10 to add more metafiles. 

12. Click on the  button in the Metafile Options window to exit this window. All the changes will be 
reflected in the Choice lists, printed dynamic legends and will be available to draw with on your existing, new or 
old logs. 

How to Delete an Added or User defined Metafile 
We will not allow the user to delete a system metafile. You are able to modify or edit a system metafile but the 
deletions of these symbols are not allowed. 

    
1. Click on the Metafile Options selection located under the Edit pull down menu. This will activate the Metafile 

Options window shown below. 
2. Click on the category of the symbol you wish to delete. This will activate a list of existing symbols shown on the 

right hand side of the window. 
3. Click on the user defined Symbol you wish to delete and it will become highlighted and fill in the edit field. 

4. Click on the  button. This will activate a System Message window. 

 

5. Click on either the  button and the Metafile will be deleted. 
6. Repeat steps 2-5 to delete more users defined existing metafiles. 

7. Click on the  button in the Metafile Options window to exit this window. All the changes will be 
reflected in the Choice lists, printed legends and on the screen and printed metafiles. 

Addendum Manual Version 10, page 25 



                             Addendum User Manual Version 10 
 

New - How to Edit an Existing Name for a User defined Metafile 
We will not allow the user to rename a system metafile. You are able to modify or edit a system metafile but the 
renaming or deletions of these symbols are not allowed. 

    
1. Click on the Metafile Options selection located under the Edit pull down menu. This will activate the Metafile 

Options window shown below. 
2. Click on the category of the symbol you wish to rename. This will activate a list of existing symbols shown on 

the right hand side of the window. 
3. Click on the user defined Symbol you wish to rename and it will become highlighted and fill in the edit field. 

4. Click on the  button. This will activate the Rename Symbol window. 

 

5. Click on either the  button and the Metafile rename confirmation window will appear 

. 

6. Click on the  button to rename the symbol. This action will put you back into the Metafile Options 
window. 

New - Core / Sample Header 
 
The Core / Sample Header window allows you to edit the information being displayed when the core or Borehole log 
header is printed. It also allows you to delete the core log header. 
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Core Log Header 

 
Alternate Core Log Header 

 
Sample / Borehole Log header 

How to Edit a Core / Sample Header 
1. Click on the Core / Sample Header selection located under the Edit pull down menu and then either Select 

Standard Format or Alternate Format. 
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2. In the Logged by field, type in the name of the person who the core is logged by. 
3. In the Top Depth and Base Depth fields, type in the Top Depth and Base Depth of the core / sample interval. 
4. In the Depth Corrected Remark field, type in the remark related to depth change that you wish to appear at the 

core log header. 
5. Activate the Slabbed check box , if you wish the core log header to be cut in half. This is not applicable to the 

Sample Log abbreviated Header. 
6. In the Quality Remark field, type in the remark related to quality that you wish to appear at the core log header. 
7. In the Remarks field, type in any other remarks that you wish to appear on the Core Log header. 

N.B. The Remarks field is limitless as the Core Header Expands to the appropriate size to accommodate the entire 
Remarks Field.  

Well Record Data portion of the Core / Sample Header window 

1. Click on the  button to enter KB and Ground Elevation. The Well window will be shown. 
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2. In the KB field, enter the KB. In the Ground / Collar, enter the ground elevation as well as the UTM coordinates 

and the Hole ID if you have them. 

3. Click on the  button or press ALT-S. This will activate the Core Header window showing the KB and 
Ground Elevation that you have just entered. 

4. Click on the  button. If the record has been successfully saved, click on the appropriate button when 
prompted with the Shortcut Options system window. 

How to Delete a Core / Sample Header 
1. Click on the Core / Sample Header selection located under the Edit pull down menu. This will activate the 

Core / Sample Header and select the Alternate or standard selections window. 

2. Click on the  button, and the Confirmation window will be shown. 

3. Click on the button, and the Core Header will be deleted. 

Field Restriction Table: 

Date DATE FORMAT Default=Current Date Optional 
Logged By 50 Character Optional 
Core Interval Top Depth 5.5 Numeric Mandatory 
Core Interval Bottom Depth 5.5 Numeric Mandatory 
Depth Corrected Remark 20 Character Optional 
Quality Remark 20 Character Optional 
Remark 40,000 Character Optional 
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Revised - View Menu – Toolbar Selection 
Turns the Toolbar on and off. This toolbar is dock able and can be moved to different places on the screen. 
The Power*Log / Core & Curve™ Toolbar… We have added a Print to Word Icon 
 

 

Revised - View Menu - Import Toolbar Selection 
Turns the Import Toolbar on and off. This toolbar is dock able and can be moved to different places on the screen. 
The Power*Log / Core & Curve™ Import Toolbar… We have added a Import Surveys Old method Icon 

 

Revised Well Formation Window 

New - Addition to Bit Record Layer functionality 

Moving Bit Records (Drag and Drop In / Out Info) on the Layer. 
1. Make the Bit Record layer active within the Drilling Progress track by clicking on the track and then selecting 

the Bit Record layer from the Layer Selection List field. 
2. Double click on the Layer to activate the Bit Record Data entry window. 
3. Depress and Hold the CTRL key (on the keypad) and click on the Bit record In or Out information and drag 

your mouse to a new location on the layer. You will see the outline of the data moving with your mouse pointer. 
Let your mouse pointer go and the information will be placed at that new location. Release the Ctrl key. 

4. Repeat Step 3 to move more Bit Record In / Out Information on a layer. 

New - Addition to Casing Layer functionality 

Moving the Casing (Drag and Drop Data) on the Layer. 
1. Make the Casing layer active within the track by clicking on the track and then selecting the Casing layer from 

the Layer Selection List field. 
2. Double click on the Layer to activate the Bit Record Data entry window. 
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3. Depress and Hold the CTRL key (on the keypad) and click on the Casing information and drag your mouse 
to a new location on the layer. You will see the outline of the data moving with your mouse pointer. Let your 
mouse pointer go and the information will be placed at that new location. Release the Ctrl key. 

4. Repeat Step 3 to move more Casing Information on a layer. 

New - Addition to Directional Survey Layer functionality 

Aligning All the Directional Survey Points 
1. Make the Directional Survey layer active within the track by clicking on the track and then selecting the 

Directional Survey layer from the Layer Selection List field. 
2. Right click anywhere within the Directional Survey layer to activate the pop-up menu. 

 
3. Click on Align Left (All), Align Right (All) or Center (All) to align all the Directional Survey Points 

accordingly. 

Moving the Directional Survey data (Drag and Drop Data) on the Layer. 
1. Make the Directional Survey layer active within the track by clicking on the track and then selecting the Casing 

layer from the Layer Selection List field. 
2. Double click on the Layer to activate the Directional Survey Points Data entry window. 
3. Depress and Hold the CTRL key (on the keypad) and click on the Directional Survey information and drag 

your mouse to a new location on the layer. You will see the outline of the data moving with your mouse pointer. 
Let your mouse pointer go and the information will be placed at that new location. Release the Ctrl key. 

4. Repeat Step 3 to move more Directional Survey Information on a layer. 

New - Addition to Formation Top Layer functionality 

Aligning All the Formation Tops 
1. Make the Formation Tops layer active within the track by clicking on the track and then selecting the Formation 

Tops layer from the Layer Selection List field. 
2. Right click anywhere within the Formation Tops layer to activate the pop-up menu. 

 
3. Click on Align Left (All), Align Right (All) or Center (All) to align all the Formation Tops accordingly. 

Moving the Formation Top Data (Drag and Drop) on the Layer. 
1. Make the Formation Top layer active within the track by clicking on the track and then selecting the Formation 

Top layer from the Layer Selection List field. 
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2. Double click on the Layer to activate the Directional Survey Points Data entry window. 
3. Depress and Hold the CTRL key (on the keypad) and click on the Formation Top information and drag your 

mouse to a new location on the layer. You will see the outline of the data moving with your mouse pointer. Let 
your mouse pointer go and the information will be placed at that new location. Release the Ctrl key. 

4. Repeat Step 3 to move more Formation Top Information on a layer. 

New - Addition to Graphics Layer functionality 

Moving the Graphics (Drag and Drop) on the Layer. 
The user has the ability to move a picture around within the confines of the layer if the Lock Aspect Ratio check 
box  has been activated. Otherwise the picture will take up the entire width of the track and there would be no need 
to move the picture. 
1. Make the Graphics layer active by clicking on the track that holds the graphics layer and selecting the 

graphics layer from the layer selection pull down menu in the selection bar. 
2. Click on the graphic and drag left or right (Power*Log / Core) or up or down (Power*Curve) and release the 

mouse button the picture will be redrawn at the new position.  
Note: The measure depth relationship of the graphic will not be adjusted in this manner. Just the position with respect 
to the layer/track edges can be adjusted. If you wish to change the top depth of the picture you must change it in the 
builder itself. 

Revised System Options 
The user can manage Power*Log, Power*Core and Power*Curve system settings with this tab dialogue 

window. Once you have made your changes Click on the  button 

General Tab 
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Home Directory - This is the directory on your hard drive where Power*Log, Power*Core and Power*Curve is 
being executed. The user will not see any symbols on their log or print out any of our reports it you have the wrong 
home directory. 

 This check box when  activated will populate the Open Log window with all the wells in 
the database. If it is unchecked it may help our corporate users and the time it take to retrieve thousands of wells 
from the database and to populate the Open Log window with that information. If this check box is deactivated and 

you wish to see all your wells then simply click on the  button in the Open Log window to see all their 
wells if this option is deactivated. 

Date Format - From this drop box, you can select the date format. This selection 
determines how every date in Power*Log / Core & Curve will be entered and displayed. If 
you import a log with different date formats, Power*Log / Core & Curve will change the 
dates to comply with the format you've chosen here. The user can change this at any time 
and all the Date formats will be changed in the database. 
 
Version Compatibility - Enables the user to achieve compatibility for Annotations in the 
older Versions of Power*Suite (V1.81 and before) and the Annotations in the newer 
Versions of Power*Suite (V1.9 and later). 

Data Buffer Lookahead - The number placed in this field determines how far ahead and behind the current top 
depth will be stored in the computers buffer. The larger the look ahead number, the longer it takes for Power*Log / 
Core & Curve to refresh the screen when you exceed the look ahead value. However, until you meet or exceed the 
look ahead value, scrolling will be much faster, because the database is not yet being accessed. 

New Fonts Tab 
This tab allows the user to set up most of the fonts used in Power*Log, Core and Curve. You can set it up to 
be used on the current log as well as using the fonts as your defaults when you are making new logs. 

 
Annotation Font - Allows you to determine the default font style, type, color and size of your annotations on your log, 
Also this is the default when you use any of the Sample Description Transfer options. 
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Survey Font - Allows you to determine the font style, type, color and size of your survey data associated with the 
Survey Layer on your log. 

Bit Record Font - Allows you to determine the font style, type, color and size of your bit record data associated with 
the Bit Record Layer on your log. 

Generic Category Font - Allows you to determine the font style, type, color and size of your Long or Short Name 
display option in all the Generic Category Layers displayed on your log. 

Depth Font - This allows you to determine the font style, type, color and size of the depth markers in the Depth track 
of the log. 

 - These radio buttons allows the user to change the orientation of the Depth Font 
on the Layer. Beware you may have to change the Track Width to accommodate the Font size and orientation. Refer 
to the Log Configuration Builder to do this. 

 This check box  when activated will display the depth units with the depth on the Depth Layer. 
ie. 1000 ft or 1000 m vs. 1000 

Track Header Font - Allows you to determine the font style, type, color and size of your Track Headers on your log. 
All track headers use the same font across the entire log. 

Layer Header Font - Allows you to determine the font style, type, color and size of your Layer Headers on your log. 
All Layer headers use the same font across the entire log. 

Formation Tops Font - Allows you to determine the font style, type, color and size of your Formation Tops data 
associated with the Formation Tops Long and Expanded Layers on your log. 

Offscale Font - Allows you to determine the font style, type, color and size of your curve values displayed when the 
curve pegs off scale.  

Core Box Font - Allows you to determine the font style, type, color and size of your Core Box data entered in the 
Core Box layer. 

Casing String Font - Allows you to determine the font style, type, color and size of your Casing string data displayed 
on the Casing String layer. This data is entered trhough the Casing String Report. 

Date Font - Allows you to determine the font style, type, color and size of your Date data entered in the Date layer. 

Core Sample Code Font - Allows you to determine the font style, type, color and size of your Core Plug data entered 
through the Core Plug Report. This font is displayed on the Core Sample Code layer. 

Sidewall Core Font - Allows you to determine the font style, type, color and size of your Sidewall Run and Sample 
Number data entered through the Sidewall Core Report. This font is displayed on the Sidewall Core layer. 

MDT Font - Allows you to determine the font style, type, color and size of your MDT Run and Test Number data 
entered through the MDT Report. This font is displayed on the MDT layer. 

 This check box  when activated will make the font setting in this window your defaults for 
any new log created regardless on the Fonts stored in the template. 

How to Set your Fonts 
1. Click on System Options selection under the Options menu selection To activate the System Options window. 
2.  Then click on the Font Tab to activate the Tab. 

3. Click on the  button beside the Font option you wish to change and this will activate the Font Window. 
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4. Select form the Font, Font Style, Size Effects and Color. When you are finished click on the  
button 

5. Repeat steps 2-4 for all Font types. 

6. Click on the  button. 
7. If you want to set these as your default Font settings click on the  check box. 

8. Click on the  button in the Systems Options Tab dialogue window. 

How to restore the System default Fonts 
1. Click on System Options selection under the Options menu selection To activate the System Options window. 
2. Then click on the Font Tab to activate the Tab. 

3. Click on the  button. 

4. Click on the  button. 

5. Click on the  button in the Systems Options Tab dialogue window. 
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Display Tab 

 

Arrowed Subintervals - This check box  when activated will indicate the top and bottom of your subintervals 
(portion of an interval) with an arrow rather than a set of symbols. An example is shown below. 

                     
 Normal Subintervals Arrowed Subintervals 
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Transparent - This check box  when activated, this function makes the background of the accessory symbols 
transparent, so that the bed in the background shows through. If deactivated, a white background surrounds the 
accessory symbols in order to separate them more from the beds. 

Use Global Symbols – With the ability to edit existing metafiles the user may have imported a well that has used 
metafiles or symbols that have been modified to look differently than the one existing within your system symbols. If 
you wish to use your symbol set instead of the revised imported ones you can select this check box  to make that 
change. 

Interbed Line Display Type - This check box  when activated will display the interbed data with a line display 
splitting the two lithology types or when unchecked will display the lithology in an interbed fashion as displayed below. 

                      

Curve Backup fill – This check box  when activated will show a sideways hatching fill pattern when a curve goes 
off scale or in the backup mode. If unchecked there will be no hatching pattern when the curve goes off scale. 

Frequency @ 1:240 – This drop box determines how often symbols are drawn on a Lithology Layer, with the scale 
of 1:240. For example: 1 symbol every 1 meter at 1:240, 2 symbols every 1 meter at 1:120, 1 symbol every 2 meters 
at 1:480, and so on. These frequencies are only in effect if you utilize the entire interval in Oil Shows, Rounding, 
Sorting, Framework, or designated an interval in Sedimentary Structures, Traces Fossils and Rock Accessories. 

Lithology Profile - This check box  when activated will fill in the Carbonate Texture and Grain Size layers with the 
interpretive lithology. It will draw the lithology to the maximum size filled in over the interval. 

Note: The user may wish to turn off the track borders when this option is selected. You will see an example of this 
shown below. 

 
Grain Size Scale List box - You may choose between Wentworth, Canstrat or Amstrat
scales, when using the Grain Size Builder. The Wentworth Grain size only allows full grain
size while Canstrat / Amstrat allow half grain sizes when drafting in the Grain size and matrix 
layers.

 
 

 

 This  radio button will display the Grain Size Track header with the equivalent verbal grain sizes 
such as such as C slt, VF snd, F snd, M snd, C snd etc. 

 Verbal Scale    MM Scale     

 This  radio button will display the Grain Size Track header with the equivalent numeric grain 
sizes (in mm) such as .0625, .125, .25, .5, 1, 2 etc. as shown above. 

 This  radio button will display the grain size with strait edges and right angles between the grain 
sizes. The illustration below is shown with Lithology Profile activated. 
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 Hard Edges        Soft Edges      

 This  radio button will display the grain size with curved edges and rounded angles between the 
grain sizes. 

Grain Size  This drop box allows the user to select a hatching 
pattern when using the Grain Size Layer with the Lithology Profile not activate. 

Grain Size  This color selector allows the user to pick the line color (foreground) when the fill 
pattern option is used. The background color is found in the Layer configuration for the Grain Size. 

    
 Grain Size No Pattern Hard edges Grain Size Pattern Soft edges 

Carbonate Texture  This drop box allows the user to select a 
hatching pattern when using the Carbonate Texture Layer with the Lithology Profile not activate. 

Carbonate Texture  This color selector allows the user to pick the line color (foreground) when 
the fill pattern option is used. The background color is found in the Layer configuration for the Carbonate Texture 
Layer. 

Carbonate Textures  This  radio button will display the grain size with strait edges and right angles 
between the Carbonate Textures. The illustration below is shown with Lithology Profile activated. 

Carbonate Textures  This  radio button will display the grain size with curved edges and rounded 
angles between the Carbonate Textures. 

-When this check box  is activated the bedding contacts (lines) 
between the drawn lithology types in the Interpretive Lithology Layer will be shown. 

 When this check box  is activated it will turn on the accessories in 
the Interpretive Lithology Layer. 

Monitor Height - This option allows you to scale your monitor for Power*Log / Core so you may correlate on-screen 
wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the vertical 
viewing area of your monitor in inches and then insert that value in the Monitor Height field. Be aware, however, that 
if you adjust the screen height knob on your monitor, this will affect the monitor height setting. 
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Monitor Width - This option allows you to scale your monitor for Power*Curve so you may correlate on-screen wells 
with hard copy logs that you may have. It is recommended that you take an opportunity to measure the horizontal 
viewing area of your monitor in inches and then insert that value in the Monitor Width field. Be aware, however, that 
if you adjust the screen width knob on your monitor, this will affect the monitor width setting. 

Note: You must restart Power*Log / Core & Curve for the Monitor Width / Height changes to take effect. 

This drop box option will display your directional surveys on your log in
either Quadrant format N 62 º W) or Azimuth format (AZ 298 º

 
) 

 

 This check box  when activated will display the Sidewall Core Run & Core 
numbers above the core triangle indicator on the Sidewall Core layer. 

Revised Favorites Tab 
This tab allows the user to define their System favorites for all the data categories that support these choices. 
This tab dialogue also allows the user to access the % Lithology Sort order for the % Lithology Track. 

 

How to Change the Generic Symbol Favorites Selection 

1. Click on the  button in the System Options window to activate the Trace Fossils 
Favorites window. 
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2. Utilize the Category Drop box to select your Generic Symbol Group. 

3. Click on the  button in the Generic Symbol Favorites list window to prepare it for the selection of 
your Generic Symbol Favorites. 

4. Select by clicking on or highlighting some of your more commonly used Generic Symbol from the list window. 

5. Click on the  button to return to the System Options window. 

6. Click on the  button in the System Options window, when you are finished. 

New - Generic Symbol Layer / Track 
This layer allows you to add or delete a Generic Symbol Category that has not been offered in Version 10 in the 
Power*Core application. This will allow the user to create a set of user defined categories and subsequent symbols 
for a new category that can be represented by these symbols. There are two types of layers. There is a Bed 
Restricted (BR) and a Non-Bed Restricted (NBR) layer types. 

The bed restricted (BR) layer type is like a typical rock property layer (sorting, rounding grain size) where you have 
to have a rock type in order to enter a diagenesis. The diagenesis is also restricted to the bed you are drawing in. 
Also, when the bed is resized or deleted the diagenesis symbol may be also resized or deleted if the diagenesis 
interval coincides with the beds resized or deleted interval. 

The non-bed restricted (NBR) layer type is not associated with any rock type or bed and can be entered anywhere 
the user wishes and will not be affected by the resizing or deleting of a bed. 

How to Add a Generic Symbol Track 

1. Click on Log Configuration Builder under the Options menu selection or click on the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window: 
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2. On the left hand side of the Log configuration window scroll down the list of tracks and click on the Generic 
Symbol track. The track will become highlighted and the Tracks radio button  will become activated. 

3. On the right hand side of the Log configuration window click on the Track you want it to go above or to the right 
of. In this example we will be adding the Generic Symbol track to the left of the Bioturbation. The track will 
become highlighted and the Tracks radio button  will become activated. 

4. In the middle of the Log configuration window click on the  button. This will activate a System 
Message asking the user “Do you really want to ADD the selected (TRACK) from the available log to the active 
log?” 

5. Click on the  button. This will activate a Get Name window allowing the user to name the track. 

     

6. Type in a Track name (Generic Symbol) and then click on the  button.  The track will be added 
above the Bioturbation Track or to the left on the log, and the Log Configuration Builder window will be shown. 
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7. Highlight either the Category Name or the Category Name (BR) so that the Layers Radio button  is 

activated and click on the  button to delete one of these layers. You will probably not want to use 
both layers on the log. 

8. Click on the  button. This will activate the Log with the new track and you will then prompted with 
adding a new Category and symbol for that category. 

 

9. Type in the New Category Name you wish to create as well as the Long and Short name for a symbol to be 

added to this new category. Click on the  button. This will activate the Metafile Editor for you to 
draw the symbol that you have just named. 
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10. Draw your symbol. Please reference the Metafile Options selection under the Edit pull down menu to review 

how to draw you symbol. Click on the  button when you are finished. You have now added 1 symbol to the 
new symbol category. 

11. If you would like to add more symbols to the category you will now have to click on the Edit Menu selection and 
select Metafile options and then highlight the category you have just added and then select the 

 button to add more symbols to your category. 

             

Adding a Generic Symbol  
Note: All bed restricted description categories, such as Generic Symbol (BR), are associated with a Rock Type and 
must have a Rock Type in order to be saved to the database. Therefore, you cannot add a diagenesis, until there is 
a rock unit or bed interval added to the Interpreted Lithology Layer for that interval. 

1. Double click on the Generic Symbol track / layer to activate the Generic Symbol Builder window and 

toolbox. The toolbox can be turned on or off by clicking on the  button in the builder. 

 

2. Right click anywhere on the Generic Symbol track / layer to activate the pop-up menu. 
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3. Click on the Generic Symbol (Core Observations) favorites list to activate the pop out menu and then select from 
the pop out list or click in the builders drop down menu selections to access the list provided in them. Either way 
once you have selected one it will be populated in the builder. 

 

4. If abundance is required, right click on the existing diagenesis, Click on the Abundance selection to activate 
the pop out menu and then select from the pop out list or click in the builders drop down menu selections to 
access the list provided in them. Either way once you have selected one, it will be populated in the builder. 

        
5. Click and drag the mouse on the track / layer over the desired interval. Or If you just click your mouse on the 

track / layer. This will insert a subinterval of whatever was selected in step 3 and will be added to the layer / track 
at the depth you clicked at. The interval size is defaulted to the screen scale accuracy setting. The Diagenesis 
interval will be drawn accordingly. 

6. Double Click within an existing rock type interval in the Generic Symbol layer with the 
 activated and the entire interval will be filled in with the attributes that have been 

entered into the Generic Symbol window. 

7. Click and drag the mouse on the track / layer close to an existing Generic Symbol (either above or below in the 

same column) with the  activated and there will be no spaces between the diagenesis. 
Remember you have to be within 10 times of the mouse pointer or screen accuracy from the previous symbol to 
have the snap to take effect. 

Note: Regardless of the thickness of the interval that you have added to the log, at least one symbol will be drawn 
in the middle of the interval. 

Tip: The frequency of symbols (if not utilizing the arrows subintervals) at any given scale is handled in the Systems 
Options window, under the Options menu selection. If you have selected 1 symbol every 2m at the 1:240 scale, you 
will get 1 symbol every 1m at the 1:120 scale, 1 symbol every 4m at the 1:480 scale, and so on. 

8. Repeat Steps 3 - 7 to add more Generic Symbol to the track. 

Note: There are two ways how abundance can be shown. If in the System Options window you have checked 

 option, each interval will be displayed with a different line style which specifies the 
abundance you have selected. E.g. if occasional, an interval arrow will be displayed as a dashed line, while if 
abundant, an interval arrow will be displayed as a thick solid line. Otherwise, all symbols within an interval will be 
displayed in the certain color which specifies the abundance you have selected. E.g. if occasional, symbols will be 
blue, on the other hand if abundant, symbols will be red. 

9. Press the Esc key on the keyboard to exit from the Generic Symbol Builder window. 
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Resizing an Interval 
1. Double click on the Generic Symbol track / layer to activate the Generic Symbol Builder window. 

Mouse Pointer Method 

2. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends. If done correctly 

the mouse pointer will turn into a resize cursor . 

3. Click and drag the mouse to the new desired top or bottom depth. Release the mouse button and the interval 
will be resized. 

Keypad Method 

1. Click once on the Generic Symbol you want to resize to bring it into the builder and change the from or to depth 

and / or abundance and click on the  button. Remember if it is a bed restricted layer that the top 
or bottom of the Lithology interval will take precedent. 

Moving an Interval 
1. Double click on the Generic Symbol track / layer to activate the Generic Symbol Builder window. 

2. Move the mouse pointer over the interval to be moved. Click and drag the interval to a new position. (The 
bed-restricted interval will not be allowed to move outside the interval of the lithology it is associated with.) 

Deleting a Single Interval 
1. Double click on the Generic Symbol track / layer to activate the Generic Symbol Builder window. 

 

2. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 

 

3. Click on Delete and the interval will be deleted accordingly. 

4. Repeat Steps 2 and 3 to delete more Generic Symbol intervals from the Generic Symbol track / layer. 

5. Press the Esc key on the keyboard to exit from the Generic Symbol Builder window. 

Deleting Multiple Intervals 
1. Double click on the Generic Symbol track / layer to activate the Generic Symbol Builder window. 
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2. Press and Hold the SHIFT Key and then click and drag an area anywhere within the intervals you wish to 

delete. 

3. Release the mouse button to activate a Confirm Multiple Delete message. 

 

4. Click on  button and the Generic Symbol intervals encompassed with your drag will be deleted 
accordingly. 

5. Press the Esc key on the keyboard to exit from the Generic Symbol Builder window. 

Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Generic Symbol layer are shown below. To access this window, click on the  Layer 
Configuration button on the Toolbar, when the Generic Symbol layer is active. 
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New - Energy / Sea Level Change Layer 
This layer has the ability graphically represent a change with an arrow either increasing or decreasing in 
an upward direction. . 

How to enter a Visual Change interval. 
1. Double Click on the Visual Change Layer to activate the Visual Change Data Entry Window. If 

the Visual Change window has data filled in Click on the  button or press ALT-N and then 
fill in a new record. 

 

2. Define the desired interval by clicking and dragging the mouse pointer within the Visual change 
layer track. The interval will be drawn accordingly. 

3. The user can right click on the symbol area and change the arrow direction the line arrow size or 
delete the arrow altogether. 

       

4. The user can also type in the Top Depth, Base Depth and select either  radio 
buttons. The user can use the TAB key on the keypad to advance through the data entry fields and Shift Key 
and TAB key simultaneously to go backwards through the data entry fields. 

5. Click on the  Button to save the record. 

6. Repeat steps 2-3 for more entries. 

7. Click on the  Button to close the data entry window or click on the  in the upper left corner. 

Resizing an Interval 
1. Double click on the Visual Display track / layer to activate the Visual Display Builder window. 

Mouse Pointer Method 

2. Press the Ctrl key down on the keypad and move the mouse pointer over the interval ends. If done 

correctly the mouse pointer will turn into a resize cursor . 

3. Click and drag the mouse to the new desired top or bottom depth. Release the mouse button and the interval 
will be resized. 

Keypad Method 
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2. Click once on the Visual Display you want to resize to bring it into the builder and change the either the number 

in the from depth or to depth and / or  and click on the  button. 

Moving an Interval 
1. Double click on the Visual Display track / layer to activate the Visual Display Builder window. 

2. Move the mouse pointer over the interval to be moved. Click and drag the interval to a new position. (The 
bed-restricted interval will not be allowed to move outside the interval of the lithology it is associated with.) 

Deleting an Interval 
1. Double click on the Visual Display track / layer to activate the Visual Display Builder window. 

 

1. Right click anywhere within the interval you wish to delete to activate the pop-up menu. 

      

2. Click on Delete and the interval will be deleted accordingly. 

3. The user can also click on the  button. This will activate a list of intervals drawn to date. Select from the 

list by double clicking. Click on the  button in the builder and the interval will be deleted accordingly. 

4. Press the Esc key on the keyboard to exit from the Generic Symbol Builder window. 
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Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Visual Change is shown below. To access this window, click on the  Layer Configuration button 
on the Toolbar, when the Visual Change layer is active. 

 

Revised Interpreted Lithology Layer - Rock Type Builder Revised 
The revisions to this builder have been to the drop lists. In the Sample Quality List we have added Rubble to help out 
our core loggers. We have also added Preserved and Missing to No Data list and last but not least we have added 
Questionable and Not visible to our Contacts list. 

 
 

The Sample quality further defines the lithology interval with one of the
three qualities such as Questionable, Poor or Rubble core / sample
quality symbols as shown on the right.

 

 

on the right.  

 

 
 

The No Data Description selection allows the user to define a 
Lithology interval on the log with one of the no data descriptions as 
shown 
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 The Base Contact Selection allows the user to add a basal contact to an 
existing Lithology interval. 

This list can be viewed from either the drop box in the Rock Type builder or by right clicking on the drawn interpretive 
lithology interval. 

 

Revised Annotation Layer 

Adding Annotations / Lithology Descriptions… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Define an area or box outline by clicking and dragging the left mouse button from the upper left corner to the 
lower right corner of the desired area to form a rectangular shape and then releasing the left mouse button on an 
Annotation layer to activate the RTF Font and RTF Lines and Boxes toolbars shown below. 
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3. Click once more in the drawn area and you will get a flashing cursor. 

 
4. Type in your annotation. 
5. Utilize the options in the RTF Font and RFT line and box toolbars to get the desired effect on your annotation. 

To change individual font characteristics you would highlight the font by clicking and dragging and then select the 
button from the toolbar or utilize the user right click inside the annotation field and select the Apply 
formatting selections to change the font style color etc. 

 
6. If you would like to undo the last action taken within an annotations formatting the user can right click inside 

the annotation field and select the Undo Last formatting selection. 
7. Click anywhere outside the annotation box to close the toolbars. Repeat steps 2-6 for more annotations. 

Drawing a Line… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Define an area or box outline by clicking and dragging the left mouse button from the upper left corner to the 
lower right corner of the desired area to form a rectangular shape and then releasing the left mouse button on an 
Annotation layer to activate the RTF Font and RTF Lines and Boxes toolbars shown below. Or just click on an 
existing annotation that does not have a line associated with it. 
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3. Click and drag the mouse and a line will be drawn. The drag must start anywhere outside the highlighted or 

drawn area of your highlighted annotation and inside the confines of the track and remain inside the track 
boundaries. 

4. Release the mouse and the line will be drawn. Utilize the   buttons for arrow heads and tails. Also line 
style and thickness drop boxes can be used to further define your drawn line. 

5. Repeat step 3 to redraw the line. 

6. Click anywhere outside the annotation box to close the toolbars. Repeat steps 2-6 for more annotations. 

Editing Annotations/Lithology Descriptions… 
1. Make the Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer 

on it and then selecting that annotation layer you want to work with from the Layer Section list on the 
Selection Toolbar. 

2. Click in annotation field box to highlight the field and activate the RTF Toolbars. 

3. Edit this field as you normally would utilizing the keypad, mouse and toolbars to edit anything inside this 
annotation field or add a line. 

4. Click outside of the highlighted text field to close the toolbars. 

Resizing Annotations/Lithology Descriptions… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Click in annotation field box to highlight the field and activate the RTF Toolbars. 

3. Place the mouse pointer over one of small boxes ( ) used to define the outline around the 
Annotation/Lithology Description and the mouse pointer will transform into a double arrow( ). 

4. Click and drag the mouse pointer to define the new size for the Annotation. 

5. Release the mouse button, and the Annotation/Lithology Description will be redrawn within its newly defined 
area. 

6. Click outside of the highlighted text field to close the toolbars. 

Moving Annotations/Lithology Descriptions… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Click on annotation field box to highlight the field and activate the RTF Toolbars. 
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3. Move the mouse pointer on the highlight surrounding the selected Annotation/Lithology Description and the 

mouse pointer will transform into the shape of a cross with four  arrows. 

4. Click and drag the mouse pointer to the Annotation's/Lithology Description's new position. 

5. Release the mouse button, and the Annotation/Lithology Description will be redrawn at its new location. 

6. Click outside of the highlighted text field to close the toolbars. 

Deleting Annotations/Lithology Descriptions… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Click in annotation field box outline to highlight the field and activate the RTF Toolbars. 

3. Right Click anywhere within the Annotation field that is highlighted to activate the pop-up menu. 

 

4. Click on the Delete selection and you will receive the following system message. 

 

5. Click on  button and the selected Annotation/Lithology Description will be deleted accordingly. 

6. Click outside of the highlighted text field to close the toolbars. 

Deleting Lines associated with Annotations… 
1. Make a Lithology Description or Annotation layer active by clicking on the track that has an Annotation layer on 

it and then selecting that annotation layer you want to work with from the Layer Section list on the Selection 
Toolbar. 

2. Click in annotation field box outline that is associated with the line to highlight the field and activate the RTF 
Toolbars. 

3. Right Click anywhere within the Annotation field that is highlighted to activate the pop-up menu. 
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4. Click on Delete Line selection and the Line will be deleted and the Annotation toolbars will automatically close 
for you. 

Revised Detailed Lithology Layer - Rock Accessory Builder 
The Rock Accessory Builder allows you to add accessories to the Detailed Lithology layer. 

Drawing Accessories 
1. Double click anywhere within the Detailed Lithology layer to activate the Detailed Rock Type Builder. 
2. Then, right click anywhere within the Detailed Lithology layer to activate the pop-up menu shown below, or 

click on the button in the Detailed Rock Type Builder window: 

 
3. Select Acc Builder selection from the pop-up menu to activate the Rock Accessory Builder window and the 

Accessory Favorites List Toolbox. 

                       

4. Select the Accessory from the Toolbox by clicking on the accessory you wish to use or right click again 
anywhere within the Detailed Lithology layer to activate another pop-up menu. 

 

Note: The graphical images utilized in the pop-up menu represent specific Accessories selected by the user in 
the System Options window (See the System Options section. 
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5. Click on the appropriate Accessory symbol from the pop-up sub-menu and the corresponding field in the 
Rock Accessory Builder window will automatically be filled in with the selected Accessory. You may also 
select a Rock Accessory from the Thinbed, Components, Matrix and Cement fields within the Rock 
Accessory Builder window, if the desired Rock Accessory is not displayed in the Accessory Favorite List 
Toolbox or the pop-up menu. 

Note: The user can get easily to the first letter of the Accessory they wish to select by clicking once in the 
appropriate field in the Rock Accessory builder to highlight a selection and then typing in the first letter of the 
component they wish to choose. This will refresh the list with the first letter and then the user can scroll through 
the selection until they see their selection and click to select. 

6. Click anywhere within an existing Detailed Lithology to insert the desired Accessory/Accessories. 

The Toolbox can be activated or deactivated by clicking on the  button within the Rock Accessory 
Builder Window. 

Revised Detailed Lithology Accessory Builder 

New - Moving a Thinbed, Components, Internal Contact, Matrix, or Cement 
1. With the Rock Accessory Builder window activated click and drag the Accessory symbol you wish to move 

and drag the red box to the new location. 

2. Release the mouse button and the accessory will be redrawn at the position. 

Deleting a single Thinbed, Components, Internal Contact, Matrix, or Cement 
1. With the Rock Accessory Builder window activated right click (in the upper right corner) of the Accessory 

symbol you wish to delete and the pop-out menu will be activated. 

 

2. Click on the Delete selection from the pop-out menu and the selected Accessory symbol will be deleted. 

3. Press the Esc key on the keyboard to exit from the Rock Accessory Builder window. 

New - Deleting Multiple Thin beds, Components, Matrix, or Cements 
1. With the Rock Accessory Builder window activated Press and Hold the SHIFT Key and then click and drag 

an area where the symbols are that you want to delete. 

2. Release the mouse button and this will activate a message. 

 

3. Click on the  button. The accessories that were covered by your drag will be deleted. 
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New Curve Editor 

Editing or Adding Values to Curves 
The following steps will show you how to edit curves and add values to an existing curve layer. 

 

The Ignore Nulls check box  when activated draws a continuous curve in the pattern predefined in the Curve 
Layer. When it is deactivated the curve will be a discontinuous curve if there are any null values associated with the 
curve data. 

How to Add values to a Curve from the Curve Editor window. 
1. To access the Curve Editor window, make the curve layer that you wish to edit, the active layer within an active 

track (see Layers Organizer or Layer Selection List). 

2. Double click on the layer to activate the curve layer's Curve Editor window shown above. 

3. If you wish to go to a specific depth in the list, click on the thumb and drag it or you can also search for a depth 
by simply scrolling down the list. 

4. Set the Auto increment field to the depth increment for the curve values you are entering. This will then 
automatically increment the depth entered by this value when you enter the value. 

5. Type in a depth in the depth field and then tab to the value field and type in a value. 

6. Press the Enter key on your keypad or click on the  button when done and the depth / value will 
be entered into the list, resulting in the depth being advanced by the number specified in the Auto Depth 
Increment field. 

7. Type in a new value for the corresponding depth and either Press the Enter key on your keypad or click on the 

 button. 
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N.B. *If the number in the Value field is the same as the previous number, then just press Enter key on your 
keypad and the program will advance it for you automatically, thereby preventing you from having to re-enter the 
same number into the Value field twice. 

8. When you are finished entering your data click on the  button. 

9. Then either click on the  button or click on the  to close the window. 

If you have no values for specific depths, you must enter the Null Value for the curve, which is displayed in the 
Header Portion of the window. The Null Value is a numeric value that symbolizes No Data for a particular depth 
point. If you have no data for a particular depth, type in the Null Value for that depth and your curve will not be drawn 
for that portion. 

How to Edit a value in the list from the Curve Editor window. 
1. To access the Curve Editor window, make the curve layer that you wish to edit, the active layer within an active 

track (see Layers Organizer or Layer Selection List). 

2. Double click on the layer to activate the curve layer's Curve Editor window shown above. 

3. If you wish to go to a specific depth in the list, click on the thumb and drag it or you can also search for a depth 
by simply scrolling down the list. 

4. To edit a value given to a specific depth, Click on the depth / value to place it in the single entry fields.  

5. Click in the Value field and type in the new value you wish to assign to the depth. 

6. Press the Enter key on your keypad or click on the  button when done and the depth / value will 
be entered into the list, resulting in the depth being advanced by the number specified in the Auto Depth 
Increment field. 

7. When you are finished entering your data click on the  button. 

8. Then either click on the  button or click on the  to close the window. 
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How to Shift values from the Curve Editor window. 
1. To access the Curve Editor window, make the curve layer that you wish to edit, the active layer within an 

active track (see Layers Organizer or Layer Selection List). 

2. Double click on the layer to activate the curve layer's Curve Editor Window shown above. 

3. To enter the depth range for the interval of the curve that requires shifting the user must first click on the 
top value in the list. Then scroll down to the last value that needs to be shifted and hold the SHIFT key 
down on your keypad and click on the last value. This will fill in the From Depth and To Depth fields. 

4. Then, type in the New from depth to where this portion of curve will be placed and then click on 

the  button. This will activate a system message. 

 

5. Click on the  button. 

6. Then click on the  button and then click on the  button. 

Note: When you shift portions of curves, anything that existed at the "New From Depth" value will be overwritten. 
The example above shifts the curve data down 32. 
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How to delete values in the Curve Editor window. 
1. To delete a single value depth and its assigned value, highlight it on the list and then click on the 

 Delete button or right click on the value in the list and select delete. 

 
2. The user has the ability now to delete multiple values at once by highlighting specific values by utilizing the 

CTRL key and clicking on the specific depth / value rows in the list. Then click on the  Delete 
button or right click on the value in the list and select delete from the pop out menu. 

3. The user has the ability now to delete a range of values at once by highlighting a specific value by utilizing 

the SHIFT key and clicking on the specific depth / value rows in the list. Then click on the  
Delete button or right click on the value in the list and select delete from the pop out menu. 

4. The user has the ability now to delete all the values at once by right clicking on the list of values and 

selecting the select all to highlight all the values. Then click on the  Delete button or right 
click on the value in the list and select delete from the pop out menu. 

5. When you are finished editing or adding to your curve, click on the  button and then click on the 

 button 

New Curve Fill Layer 
In Power*Suite, this layer type allows you to create a visual effect with curve data. This layer will allow you to fill an 
area between 1 curve and a track edge, fill to a value, fill from a value or surround a curve (eg. 1/2” either side of a 
curve). You also have the ability to set 2 curves and to fill between two curves, fill when one curve is greater or when 
one curve is lesser than the other curve. The curve fill options can be a solid color, a hatched color, a single lithology 
or the interpretive lithology. 
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How to Add a Curve Fill layer to an existing log 

Click on Log Configuration Builder, under the Options menu selection, or use the  Log Configuration 
Builder button on the Toolbar to activate the Log Configuration Builder window. 

If you do not see the SYSTEM name beside the  button then, click on the button at the upper 
left corner of the Log Configuration Builder window to activate the Log Format List window. 

Select the SYSTEM [SYSTEM] from which to take available tracks or layers by double clicking on one of the 
SYSTEM Logs in the Log Format List window. 

On the left side of the window, click on the Curve Fill Track containing the Curve fill layer.  

Click on the Curve Fill Layer, that you wish to add to your log, within the Layers section on the left side of the Log 
Configuration Builder window. 

On the right side of the window, highlight the track that you wish to add the selected Curve Fill layer to. 

1. Click on the button to add the selected layer to the track on your log and the following system 
message will be activated, "Do you want to ADD the selected <LAYER> from the available log to the active 
log?" 

2. Click on the  button to activate the Get Name window. 

3. You now have the option of either renaming the layer or simply leaving it with its original name. 

Note: Two layers cannot share the same name. Accordingly, no layer will be added to your track if they share the 
same name as a layer that already exists on the active(your) track. 

4. Click on the  button to add the layer to your log and place its name in the active Layers list on the 
right side of the Log Configuration Builder window. 

5. Click on the  button to get out of the Log Configuration Builder Window. 

New - Curve Fill Layer (Well Path Option on Single Curve) 
In Power*Suite, this layer type allows you to create a visual effect with curve data. This layer will allow you to fill an 
area surrounding the well path curve (e.g. 1/2” either side of a curve). It has been designed to take the interpretive 
lithology drawn and surround the well path curve in the Horizontal (Power*Curve) application. It will also be beneficial 
when the correlational module has been perfected. The user now has the ability to manipulate the angle of the 
bedding contacts and the extend of those beds past the areas previously drawn. An example is shown below. 
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How to Set the Well Path Curve Fill options 
You will need the well path curve and the well path curve scale available for the user to be able to fill in the options 
correctly. The easiest way to populate the well path curve with digits would be by calculating the survey points and 
updating the well path curve with the digital data. Without actual survey data generating the well path curve this 
layer will not work correctly. 

Once the curve fill layer has been added to your log the user can now utilize the curve fill layer. To set the Curve Fill 
Options the user must first make the Curve Fill Layer active. To do so the user must click on a track containing the 
Curve Fill layer and then selecting the given Curve Fill layer from the Layer Selection List field at the far left of the 
Selection Bar. 

1. Double click anywhere within the Curve Fill or layer to activate the Curve Fill Options window.  

2. Click on the  button. This will activate a list of curves associated with this well. 

3. Click on the Well Path curve name to use so that it gets listed in the upper portion of the window and then click 

on the  button or double click on the Well Path curve that has been generated by the survey 

data. You will now view the curve name below the button. 
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Curve Options Portion of the Window. This information is pertaining to the Main Curve and its Curve attributes. 

1. Click on the Pattern Type down arrow and select the correct curve pattern for the main curve. The default 
is PtoP (Point to Point). 

2. Click on the Grid Type down arrow  and select the correct curve grid type for the main curve. The default is 
Linear. 

Fill Options Portion of the Window (1 Curve) 

3. Click on the Fill Modes – 1 Curve down arrow  and select the Well Path from these options. 

4. Type in the Width field how wide (in inches) you want the fill to be surrounding the well path curve. Example: If 
(1) is type into the width field then the fill will be ½” either side of the curve. 

5. Click on the Fill Patterns down arrow  and select Interpretive Lithology. 

6. Click on the  button. This will activate the Curve Fill TVD Scales window.  

 

7. Type in the Bottom and Top scales in their appropriate fields. Leave the depth interval from and to @ 0’s. This 
scale has to be the same scale utilized on the well path curve on your horizontal log. 
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8. Click on the  button.  This will activate the Shortcut Options window. Click on the  button. 

9. Click on the  button in the Curve fill Options window. The window will close and the changes you have 
made will be reflected on the layer. 

Well Path Curve Fill Layer – Bedding Angle Contacts builder 
Once the curve fill layer has been customized to be a well path single curve option as described above to get to the 
builder the user must first make the Curve Fill Layer active. To do so the user must click on a track containing the 
Curve Fill layer and then selecting the given Curve Fill layer from the Layer Selection List field at the far left of the 
Selection Bar. 

Single Value Data Entry 
1. Double click anywhere within the Curve Fill or layer to activate the Choose Editor window. 

 

2. Click on the  button. This will activate Bedding Angle contact window. This window displays 
the lithology data that has been entered through the Interpretive Lithology builder with the default setting in this 
window as 0 degrees bedding angle and a plus minus (departure encounter) of 10 meters. 

 
Mouse Pointer method 

3.  To modify a single bed the user can either click on the bed within the layer. The bed outline will change from 
red to blue when selected and will also be highlighted with a grey color in the builder. 

4. Hold the CTRL Key down on the keypad and click on the corner or end boundary of the bed This will result 
in an  or  cursor arrow and click and drag it in a certain direction. You will see the outline of the bed follow 
your mouse. When released the bed will draw an area surrounding the curve within the boundaries defined by 
the box with the width as specified in the curve fill option window. 

Keypad Method 

5. To modify a single bed the user can either click on the bed within the layer or in the builder. The bed outline 
will change from red to blue when selected and will also be highlighted with a grey color in the builder. 
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6. Here the user can change the type in a new bedding angle + or – to change the angle of dip as well as the 
extents with a (–) negative number in the Encounter Extent to further the bed to the left or a (+) positive number 
in the departure field to further the bed to the right. 

7. Click on the  button. The bed outline will be drawn in an area surrounding the curve within the 
boundaries defined by the data entered in the fields. 

Multiple Value Data Entry 
1. Double click anywhere within the Curve Fill or layer to activate the Choose Editor window. 

 

2. Click on the  button. This will activate Bedding Angle contact window. This window displays 
the lithology data that has been entered through the Interpretive Lithology builder with the default setting in this 
window as 0 degrees bedding angle and a plus minus (departure encounter) of 10 meters. 

 

3. To modify multiple beds at once the user must Type in the range of the beds as defined in the interpretive 
lithology builder (this must cover the entire interval of the bed) in the From and To fields that users wish to 
modify. 
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4. The user can change the type in a new bedding angle + or – to change the angle of dip as well as the extents 
with a (–) negative number in the Encounter Extent to further the bed to the left or a (+) positive number in the 
departure field to further the bed to the right in their appropriate fields. 

5. Click on the  button. The beds outlines will be redrawn in an area surrounding the curve within the 
boundaries defined by the data entered in the fields. 

Note. When two beds intersect each other on this layers presentation they will be drawn with an interfingering pattern 
as shown below. 

 

Note: When you add any layer to a log, it is always associated with a Data Type. Every data type in Power*Log / 
Core & Curve has a default setting. The default settings for a Curve fill layer are shown below. To access this 

window, click on the  Layer Configuration button on the Toolbar, when the layer is active. 
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New - Right Click Curve Option for Point Indicators to Display in Track Header  
The Point Indicators Selection indicates where the data points on the curve are being drawn with. This field is 
changed by right clicking on an active curve layer, moving the mouse pointer over the Point Indicators selection and 
clicking on any of the pop out menu selections. New If the point indicators are turned on these will also 
presented in the Track header. 

 

New - Right Click Curve Option to Display Off scale values on the layer 
The Offscale Numerics Selection allows the user to view the values of any curve that wraps itself off scale on the 
double wrap. These fonts can then be modified in the System options under the Font tab 

                  
 

New - Right Click Curve Option Change Scale Line Color 
We have added the ability to indicate the depth of a curve scale change. This is represented by a solid line across the 
layer. We have also revised how a curve crosses the curve scale. We will now draw a curve to the curve scale line 
indicator depth on the previous scale and we will start the curve on the other side of the curve scale line indicator with 
the new scale leaving no gaps in the data represent on your log 

The Scale Change Line Color Selection allows the user to view a scale change with a solid line color selected by 
the user. This scale change line is a solid line across the layer at the depth the scale change. The scale change line, 
to be viewed on the layer must first be initiated in the Edit Layer selection where this line can be turned on or off. 

Right click on the active curve layer and select Scale Change Line Color. This will activate the color picker. 

Select a color from the Basic color palette or use a defined custom color. Click on the  Button. 
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New - Right Click Curve Option Change Scale Line Thicknes 
The Scale Change Line Thickness Selection indicates the width of the scale change line in pixels. To change the 
scale change line indicators thickness, right click on an active curve layer, move the mouse pointer over the Scale 
Change Line Thickness selection and clicking on a new thickness. 

 
 
 


